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GibbsCAM 12 Update List
The following is a collection of improvements and fixes to the latest GibbsCAM 12 software dating back to GibbsCAM v11.8.8.0
Each option collapses, please click the + or - to collapse or re-expand each section.

12.0.30.0
Bug Fixes
- Fix to tools going missing after a copy and save. (49415)
- GibbsCAM no longer crashes attempting to open a Tool. (49399)
- Fixed the Classroom Installer to pick up the 'PostIO.dll' file from the correct EDU folder.(49395)

12.0.29.0
Enhancements
- Do It button is now be enabled/disabled as requested. (49252)
- Added "Distance of the Face Stock from the Chuck or Part Station" variable for scripting. (49224)
- Added Macro Command to get Programmer Notes & Part Comment. (49232)
- Added macro command to for Radial Buttons for Offset tab. (49240)
- Added macro command to Always use Markers for a Single Shape. (49241)
Bug Fixes
- 'Process Both Directions' no longer crashes GibbsCAM. (49223)
- Fix Contour is inconsistent when improper ZStock amount is used. (49248)
- Op Sim/Machine Sim - Now able to complete entering values in fields "Tools Or DCD dialogs" while Sim is active. (49222)
- Skip invalid ops or CSes when building the TMS instance list. (49237)
- Stamping values to defaults when user modifies them so when they go back to look at other set they will be seeing what they just
typed in. (48732)
- Tool Sim - now displays turning tools in the correct orientation. (49221)
- Tool list now gets cleared when loading a process. (49251)
- Fix to opcoolanttype possibly causing a crash on ops with bad coolant info. (49219)
- Fix to Thread N style not being preserved properly when the "Other" checkbox is checked. (49167)
- Fix to calling angle feed on cycle definition line. (49281)
- "Auto-Double Diam Axis" no longer doubles canned cycle values. (49227)
- Forced the PostEngine to output longhand for GibbsCAM 12 MultiPart post behavior since not all posts/control paths call the part
loop when back and forth is enabled. (49228)

12.0.28.0
Bug Fixes
- Fix to 3D mouse related crash when opening a corrupt part file. (49014)
- Fix to problem loading processes. (49101)

12.0.27.0
Enhancements
- Groove Cycle now recognizes removed material in a specifc use case. (48866)
- Add support for custom drill cycles & utility templates to use the global path. (48877)
- Updated the preview pane. (49009)
Bug Fixes
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- "ALT" key function to interrogate is now working on "Nominal Xd", "Major Xd" & "Minor Xd" fields. (48854)
- Document Control Dialog correctly preserves "Multi-Part" tab, for Generic Lathe MDD's. (48857)
- A bug has been fixed with Clearance Volume inter-operation moves that could cause a crash into material. (48869)
- At Redo Selected Ops & clicking on any Op List tiles, previous created Operations no longer disappear from the Op List. (48874)
- Rough Pinch Turning Produces no longer gouges in the toolpath. (48876)
- Op Modifiers>Change Speeds and Feeds - 2D Sharp Internal Corners are no longer ignored. (48859)
- Progress Bar> "Elapsed Time" no longer adds time with Every Redo, Redo Selected Ops & Redo All Ops. (48873)
- Fix to mill form tools not showing the correct number of holders. (48878)
- Pinch Turning Process is no longer available, when MDD only has a single TG. (48588)
- Changing tool size values no longer crashes GibbsCAM. (48852)
- Lathe Groove Cycles Process - Tool number are now preserved in Op tiles when creating multiple Groove Cycle Processes. (48856)
- Fix to creating a new material populating the new material window with the contents of the first material in the list when the
selected material was the one that was duplicated. (48855)
- Saved Tools now display on the Tool flyout at is initial creation. (48880)
- Fix to GibbsCAM crash when using Save As... in a specific case. (48312)
- Fix to Pack and Go files producing "Intermediate Tooling " bmp error messages clicking on Tool Set Up Data from the Tool Dialog.
(48621)
- Fix to SFM & IPM values not updating in Custom Material Database. (48849)
- Fix to missing reverse arc in default layout. (48853)
- opening on non-vnc files not using the default part when the preference was set in the file preferences tab of the preferences dialog.
(48863)
- No crash when attempting to open the DCD while system is busy opening part file. We no longer allow command dispatch during
file open. (48868)
- Jogging axes in the Show Position dialog now works. (48788)
- "Zigzag" Multipart option no longer causing Posting Error. (48858)
- Deleting axis from tree does delete axis from Extended MTG. (48870)
- Fix to moving a tool in tool manager now properly moves the tool to a new tile. (48598)
- Fix to lathe thread dialog shouldn't double Nominal Dimeter, major diameter or min diameter. (49029)

12.0.24.0
Enhancements
- You can now call AllowPolarInterp(TRUE) on a post that has the form setting for polar disabled and it won't turn it back on
again. (48626)
Bug Fixes
- DrillCycle.Field.Depth now affected by Every Holecheckbox. (48496)
- Integrated Safenet fix for Windows 10 Build 1803. (48764)

12.0.23.0
Enhancements
- Process & tool files have less data preserved in them from their source part. (48338)
Bug Fixes
- Adding a Toolblock for the 2nd time, Toolblock's are now displayed, in the Preview Rendering Image. (46818))
- SetReverseMSpindle works in UKM posts. (48068)
- Thread tool translation in cs-CZ GibbsCAM for "Acme & Stube Acme" now displays correctly. (48410)
- Fix to crash when utility process & mill process dialogs can be on the screen at the same time. (48434)
- Fix to Advanced 3D core using Microsoft Runtimes that have bugs in them. (48454)
- Fix to crash when changing from lathe tool to mill tool and the last used mill defaults had a tool with more toolgroups than the
current part could support. (48591)
- Short Cut key "CTRL+T" now working to reverse arc text dimensions. (48597)
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- Op Sim/Machine Sim- RoundOver Milling Tools no longer displays inconsistent results in Simulation. (48600)
- Machine Sim - " Play" is no longer ignored after "Stop At Part Load/Unload". (48601)
- Replaced a missing string responsible for displaying the label "ISO Style" for Lather Groove Thread tools. (48606)
- Bore flutes are now correctly rendered. (48611)
- Fixed a gouging issue associated when using the "Do not hit flats" option with Mill Pocketing. (48612)
- B-axis lathe MDD axis approach fixed. (48613)
- Retain View palette position when closing and re-opening GibbsCAM. (48622)
- Fix to GibbsCAM becoming responsive to user interaction too early in the process of opening a file, causing actions to be
performed before the file is fully opened and causing crashes. (48624)
- Fixed an issue occurring when rapidly selecting Operations tiles. (48682)
- Facet body stock is now working without SolidSurfacer license. (48625)

12.0.21.0
Bug Fixes
- GibbsCAM no longer crashes during Machine Simulation. (48382))
- Machine Simulation now displays a rotated tool holder in the correct orientation. (48383)

12.0.20.0
Bug Fixes
- GibbsCAM will now display the correct file size within the Windows Control Panel. (48232)

12.0.19.0
Enhancements
- Improved the error message shown if Posts do not support Clearance Volume. (48227)
- Added Support for NX 12 files. (48184)
- Gibbs will now add the toolgroup name (when applicable) to tool preview dialog. (48142)
Bug Fixes
- Changed the way that thread values are calculated when changing major diameter, minor diameter or thread height. (48138)
- Alt interrogating (Z) field for Center Position no longer incorrectly doubles the value. (48141)
- Redo Op on a Legacy Lathe Hole process no longer produces error message: Invalid Process Value. (48284)
- Z stock is no longer ignored when use stock is checked in zigzag pocketing. (48147)
- Import of .SAT file types now imports the solid correctly. (48160)
- Machine Sim - No longer produces reported false collision in Simulation. (48146)
- Gibbs will no longer crash when creating a tool in a part without multiple toolgroups after changing from an MDD that had
multiple toolgroups. (48183)
- Calc RPM, incorrectly doubles the calculation values for "Speed: RPM" in Lathe Thread Processes (48173)
- Enabling "Always Show tool preview on hover" or Turning Balloons On, no longer produces multiple icons in the Taskbar when
preview is displayed. (48177)
- Within Contour Processes, applying a "Project 2D Toolpath" with "Back and Forth", no longer incorrectly produces several
passes at each Z Step level. (48186)
- GibbsCAM no longer crashes when applying "One Flat on Each" from Solids Alignment & "Save As". (48180)
- After placing Variable Feedrate Markers and moving them around you can now correctly place new markers. (48169)
- Gibbs no longer crashes after redoing ops and zooming in during machine simulation. (48246)
- Mill Contour now correctly produces toolpath with Ramp Down enabled. (48187)
- Machine Sim - Intermediate Tooling is now detecting Collisions in Simulation. (48181)
- Text Dimensions are no longer produced when features dimensions are deactivated. (48162)
- "Stock-Display Only" & Fixture-Display Only" buttons no longer display grayed out, when selecting solid Bodies from the body
bag. (48158)
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- Machine Sim no longer rarely displays no material removal during simulation. (48140)
- Trying to assign the "c" key as a shortcut no longer automatically selects the File Open command and changes that shortcut
instead. (48135)
- We will now allow access to hidden Windows taskbar when GibbsCAM is maximized. (48242)
- We now properly allow use of unmodified keys bound to shortcuts in text fields. (48157)
- Path Finder now correctly opens to User set data folder location. (48154)
- "Save Selected Tools" button is no longer grayed out when creating a custom toolbar on a 2 Axis Lathe file. (48167)

12.0.17.0
Enhancements
- Added a new WhatsNew that displays when you first launch GibbsCAM. (48079)
Bug Fixes
- Uninstalling GibbsCAM will no longer cause an issue where the GibbsCAM Transfer Add-in is missing from SolidWorks.
(47951)
- PlugIn Manager is now properly triggered by Control + Any Hotkey. (48119)
- GibbsCAM de-AT is no longer missing HLathe5a.mdd and VLathe5a.mdd. (48071)
- GibbsCAM no longer crashes when activating Analyze Cut Part after rendering the operation. (48128)

12.0.15.0
Enhancements
- Feeds and speeds are now validated before creating operations and a error is displayed if the value is 0. (47813)
- Thread Whirling process now has a spindle choice menu. (47812)
- Added a clearer error message when there is an error with the input Z Pitch/Step in Mill Bore processes. (47806)
- GibbsCAM now supports import of SolidWorks 2018 files. (47807)
Bug Fixes
- Toolgroups are now displayed on the Tool Tile correctly when there is more than one toolgroup on the machine. (47800)
- GibbsCAM will no longer freeze during posting when "Prefer Subs" is checked in Contour Processes. (47775)
- Generating reports from DCD > Setup TMS > Info now functions properly. (47801)
- Rendering using Color mode now displays material for cleanup. (47851)
- Face Milling no longer produces a Rotate and Duplciate toolpath when the function is not available. (47764)
- GibbsCAM no longer crashes when Fixture Configuration is not found for Intermediate Tooling at opening the file. (47811)
- Angle field values in Mill processes are now retained properly. (47803)
- False Collisions are no longer detected in Simulation. (47804)
- There is no longer an endless error loop when a process tile is set to a machining, then to a utility, then back to machining.
(47584)
- Redo on legacy operation no longer generates air cutting when selecting mixed shapes. (47823)
- Pitch and TPI values are no longer confused within Lathe Threading processes. (47821)
- Tool lists are now getting updated properly when switching MDDs on an open part. (47799)
- Custom Tool Bars> "Load Tools" button no longer displays grayed out and disabled. (47818)
- Added a fix to intermediate tooling drop down not preserving value in some cases. (47817)
- Tool flyout no longer comes up with the tool has already been defined from a tool to process list drag. (47808)
- Fields within Op Modifiers > Hole Process> Spot Diameters are now updating upon changes. (47802)
- Error messages in Task Manager are now properly translated. (47797)
- Icons for "Load Tools"' & "Sort Tools" now display properly. (47730)
- Within 5-Axis the tool holder is now passed to the 5-axis module correctly. (47959)
- Fixed the ability to set or get Adv 3D Lace Cut XY stepover amount via macro. (47816)
- Enable interrogation (with Alt + Click) on Volumill Solids depths diagram. (47958)
- GibbsCAM no longer crashes when changing CP3 values and Redo the Op. (47922)
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- Hole features will now only be activated when an actual hole feature is selected when a drilling (or 5-Axis drilling) process is
performed. (47906)

12.0.11.0
Enhancements
- Added Save/ Load tool list to the API. (44278)
- Iscar Tool Advisor documentation has been updated to specify the new location. (47081)
- Tool position datain tool flyout in is now being displayed in a more user friendly way. (47303)
- When CRC is applied within Thread Milling Processes a warning message is produced that the value must be greater than 0 if
CRC line is 0. (47565)
Bug Fixes
- Change process flyout no longer closes when choosing change process. (47571)
- Creating and deleting an alloy no longer causes an exception to occur. (47556)
- Within Custom Tool bars, entering a value in a highlighted field no longer opens geometry dialogs. (47564)
- Import DWG no longer draws & facets for each sheet during import, significantly decreasing the time to import the file. (47560)
- Zigzag no longer produces toolpath outside the boundaries of the geometry selected. (47579)
- Face angle value is now being preserved in lathe groove tools when using "Other". (47580)
- Basic Utility Ops no longer shows up in Utility Group selection of process flyout. (47586)
- Edit Menu" Paste" no longer displays grayed out, when "By Diameter Range" dialog is open. Added support for unselected
cut/copy passthrough for MCP edit control accelerator handling. (47573)
- Only when Mill MDDs have the capability for Util ops is the gray "U" icon is present. (47587)
- Disable cut fitting for helical features in simulation. (47581)
- Machine Sim - "Next Feature" performance is no longer dependent on simulation speed slider. (47567)
- Autodesk files now low via Vault PLM plug-in from Vault Professional. (47643)
- Machining CS is now properly being set in cases where there were multiple part stations in a part. (47582)
- Virtual Gibbs Migration tool properly migrates data when launched from the installer. (47182)
- Documentation on GeoTools has been updated to reflect current functionality. (46856)
- Documentation on TMS has been updated to reflect current functionality. (46898)
- Collision between Intermediate Tooling Fixture and the Part Station Table, is now being reported. (47585)
- Cut Color Mode is no longer being overridden during Machine Sim. (47663)
- Redoing legacy VoluMill operations no longer removes toolpath from the second Volumill operation. (47664)
- Ignore Stock option in VoluMill is no longer always enabled. (47665)
- Threadmilling process no longer gets corrupted last used values causing a crash. (47562)
- Form tools that were not fully defined can now be deleted. (47657)
- Lathe Rough Process 'Xr Stock' values no longer produce undesirable Rapid Retract moves. (47591)
- Chamfer angle of tools created within AutoWiz now properly match the hole feature angle. (44322)

12.0.9.0
Enhancements
- You can now drop op tiles on top of other op tiles and the list will accommodate the insert. (47220)
- When posting you may now output Windows user name using "CurrentUserName$" command. (47377)
- Updated SolidWorks Document Manager to support SolidWorks 2018 files. (47234)
Bug Fixes
- Find Ops command no longer produces unspecified errors. (47009)
- Opening 5-Axis process windows no longer causes crash. (47192)
- Within Op Sim after the first Cut Off Process, Stock no longer disappears from the Work space. (47293)
- 'Align Plane Through' & 'Align Plane Through & Move' custom commands now work the same as the command in the CS
palette. (47305)
- Mach CS title no longer overlaps in French GibbsCAM (47293)
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- Within Advanced 3D, toolpath no longer gauges when using a very small Cutting Tolerance. (47317)
- Rotate button in Operation dialog is no longer shown when the operations part station does not have usable 4th rotary axis.
(47295)
- GibbsCAM now automatically selects the available parameter field when opening the dialog to add a Stop for simulation. (47307)
- Within the DCD > Workspace, "Tool Change" checkbox is now the same size as other checkboxes when using a 4k display.
(47331)
- Saved Tools with Custom Solid Tool Holders now preserve the solid body and property names. (47312)
- Tool Orientation image no longe rdisplays very small on scaled high resolution screens. (47730)
- Tools now update circle tool diameter in the workspace when using 'Mouse Point' (47338)
- Collisions between grouped components on the same WP lineage separated by at least one axis are now being detected in
simulation. (47323)
- Documentation on CutData.txt and Material.txt files has been clarified. Specifically within Common Reference. (47420)
- PartRunTime now outputs the time as a number that excel recognizes so that it can be properly formatted. (47337)
- 'Unhandled Exception' is no longer shown when opening DCD dialog on parts with invalid data. (47306)
- Collisions between stock and intermediate tooling are now being detected. (47311)
- System now looks in the additional files path for creating pack and go. (47296)
- DCD Graphic Distance is now working properly with Op Sim on specific files where it was not working. (47425)
- Erorr message displayed within Advanced 3D can now be closed easily. (47351)
- Round inserts no longer get stuck in "Other" mode when using metric parts and metric units. (47332)
- "Machine Info" no longer requires a part to be open to be used. (47404)
- Czech GibbsCAM no longer crashes when beginning your search with letter that can also be Cyrillic in the command search bar.
(47379)
- Finnish GibbsCAM no longer has locked Hit Flats option for Mill Rough process. (47407)
- Right Click > "Edit with GibbsCAM 12.x.y.z" on various CAD files will now import them correctly into GibbsCAM. (47102)
- "Do it" shortcut on Processes will now correctly save all values in dialog prior to generating toolpath. (47357)
- Using 'Delete' for text in the DCD no longer tries to delete the feature selected in the workspace. (47277)
- System is no longer overloaded when redoing dense toolpath in VoluMill. (47376)
- Removed possibly of losing selected toolholder when opening an existing tool. (47355)
- A blank error messages is no longer produced when using an overlap amount that is too large for the cut diameter. (47310)
- Import IGES draws & facets each sheet, no longer significantly increasing the time to import the file. (47414)
- Cut/Operation Color Mode settings are now preserved from legacy part files. (47320)
- Shift + Arrow Keys when trying to select text the the DCD>Comments (either comment section) no longer rotates the part in the
workspace. (47333)
- Custom 'API' Menu for Productivity+ commands no longer created each time you launch GibbsCAM. (47417)
- GibbsCAM now set last-used coolant correctly from process data if it's been overridden by another mill op or Process Manager.
(47179)
- Icons names for "Solid Modeling & "Surface Modeling" no longer incorrectly display the same name in French. (47285)
- Adjusted tab order in VoluMill. (47443)
- GibbsCAM now reverts the workspace view to it's pre-report view after running a report. (47326)
- Tool previews will update on tool orientation changes. (47328)
- Tools now highlight after being loaded from loading a Process. (47335)
- Holding 'Ctrl' key no longer shrinks the cursor quite so much on high resolution displays. (47329)
- Virtual Gibbs now correctly creates a Virtual Gibbs ProgramData folder. (47237)
- DWG files now open correctly in all languages. (47478/ 47359)

12.0.6.0
Enhancements
- The Installation Guide has been updated to reflect how to achieve a Silent Install of GibbsCAM. (45975)
- What's New has been updated to reflect that GibbsCAM can import PMI data from SolidWorks files. (46480)
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- Updated the Axis Block definition in help. (47152)
Bug Fixes
- Minimum Feedrate box in VoluMill now accepts arithmetic. (47117)
- Posting "selected ops" twice consecutively no longer produces drastically different output each time. (47123)
- Stock field values are now properly preserved within a lathe contour process. (47167)
- Operation Tiles no longer sometimes become invisible after posting (47166).

12.0.5.0
Enhancements
- Enhanced the way that GibbsCAM sorts tools. (47035)
Bug Fixes
- Creating tools via the the tool list and the process flyout now preserve the same offset & tool id shifts. (47087)
- Fixed some typos in the Multipass Stich command. (46953)
- EachSortedTool loop now works properly. (47095)

12.0.3.0
Enhancements
- Improved Axis Block documentation. (47043)
- Improved What's New documentation. (46941)
Bug Fixes
- Undo no longer reopens the History dialog of a solid when trying to undo a different action. (47079)
- CTRL + T (Reverse arcs) now works when selecting multiple circles to Reverse the Arcs. (47061)
- Finnish GibbsCAM 12 is no longer missing Operation Summary template files. (47008)

12.0.2.0
Enhancements
- Increased the size of the GibbsCAM Trash Can button. (46997)
Bug Fixes
- Multipart stock count values are now getting retained. (46885)
- DCD part comment now remains focused on the current entry. (46945)
- Disabling the additional VMM path in the Preferences will now resort back to the default path. (46948)
- Op. Sim Target body will now stay in sync with the material body. (46949)
- "WG info" command now opens the workgroup info dialog. (46951)
- Sync dialog graphics are now updating correctly when moving a tool to a different tool group. (46956)
- Workspace Geometry can now be deleted from selection in the Work Group List. (46957)
- Toggling between "Tool Holder" and "None" will not change the tool start position during rendering. (46958)
- End feature maker can now be dragged along the feature on the profile. (46959)
- Pasting text inside the DCD Part Comment and Programmer Notes no longer gets duplicated. (46960)
- Preference "Open Process Dialog on Op Load" will move focus to the process window when it's opened. (46961)
- Units in the Materials dialog will match the units used by the part file. (46981)
- Microsoft Visual C++ 2005 Redist x64 will now get installed after uninstalling a previous version of GibbsCAM. (46984)
- Preferences for setting up and searching for the post editor now display the correct executable file format. (46988)
- Loading the Tool List will now load a complete list. (47023)
- Dimensions palette no longer remains active when moving the focus to another palette. (47027)

12.0.1.0
Bug Fixes
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- GibbsCAM 12 now correctly installs Visual C++ 2008 Redistributable version 9.0.30729.6161 in order for it to run on new
systems. (46915)
- Material.txt is now correctly installed into the ProgramData directory. (46909)

12.0.0.0
Enhancements
- Added a new macro command to create a new feature from the current selection. (46871)
Bug Fixes
- Remote MDD folder now properly updates the DCD after setting the remote load folder. (46875)
- Modifying a pre-existing material within the materials dialog no longer generates an unhandled exception. (46861)

In Beta
Enhancements
- Node Position synching is now maintained on a per axis basis instead of a per toolgroup basis. (46235)
- Reporter can now output selected ops or selected tools. (46604)
- Search bars now recognize unicode words when typing the word without the unicode. (46679)
- Added a rotate tab to the Groove Cycle plug-in. (44097)
- Added the ability for the reporter to output selected ops or selected tools. (46604)
- Added support for Czech, Polish, Turkish, and Hebrew characters in the Moorpark Font. (44101)
- Improved Moorpark font efficiency for engraving the glyphs P, B, R, Ř, Ŕ, and ® by merging the vertical stem with the top loop.
(46586)
- Updated the GibbsCAM reporter template files. (46511)
- Solids in body bag now show the user color assigned to the solid. (46497)
- Part Preview updated to show MDD and VMM type in the open dialog. (44190)
- Added a progress bar to the Migration Tool. (45525)
- Multiple preset interface choices are now installed to the location of GibbsCAM in a folder named "User Interface Layouts".
(45148)
- The "Edge Selection" and "Render Solid and Edges" icons have been made more distinguishable. (46384)
- Added Lathe Tool > Laydown Thread "UN" style threads. (44221)
- Red CW and CCW rotary direction arrows have been added to B Axis Head MDD Machine Setup in DCD. (46315)
- A new interface has been added to allow control of linear/ rotary axis order during inter-rotation connects. (43885)
- Upgraded the Tool Preview Flyout. (46011)
- Different CSs no longer produce the same euler angles. (45310)
- Posting multiple drill ops with holes selected at different Z heights now correctly outputs the Utility Data comment. (45760)
- The option for Tile List transparency has been added for operating systems Windows 8 and up. (46108)
- Changed metric spline machining tolerance default to .001. (46078)
- Clearing the process list now automatically scrolls the list back to the top. (46104)
- Default transparency of the floating toolbar has been decreased. (46106)
- Hover transparency of the process list tumor is now controllable. (46107)
- Mouse Position command state now toggles with dialog presence. (46113)
- Added "Full Retract" option to the Thread Milling dialog. (43195)
- Added "Overlap" option to the Thread Milling dialog. (43195)
- Materials dialog now allows deletion of unwanted materials directly. (40138)
- Added the ability to define a "remote" folder for loading of VMMs, MDDs and Machine Models. (45966)
- Op/ Process manager now displays Lathe Orientation information. (44133)
- Lathe operations can now use fact body's as spun stock to produce material only toolpath. (21575)
- Added the ability to mirror Groove Tools. (42680)
- Added a level 1 User Interface option within preferences. (45969)
- Import of SolidWorks 2017 files is now supported. (44604)
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- Added a preference option to "Interface" tab, above "Zoom to Mouse" for "Always show tool preview on hover". (45849)
- The Do It and Redo buttons are now available with a quick right click. (45712)
- An alert will now be shown when overwriting a post output file when posting form ProAXYZ. (45806)
- Added Xr/Z stock capabilities for VoluTurn. (45128)
- While importing Spatial files import states "Reading File". (45225)
- New part reporter commands have been added: PartOffsetX, PartOffsetY, PartOffsetZ. (45788)
- Added the ability to display Intermediate Tooling/Fixtures in Tooling Data Reporter. (42043)
- A scrolling feature has been added to the CS pulldown menu. (45626)
- The "Sort" option has been removed from the OP list to avoid it being pressed accidentally. (45138)
- CS number is now included in the Tool Plane Direction CS list. (39045)
- New parameter MINIMIZE_SUBS added to SET_POST_DATA and GET_POST_DATA commands. (45083)
- Mill Multipart has been integrated into the DCD. (43294)
- Do It/ Redo is now available during simulation. (45680)
- Added "Save a copy.." to 11.3 to the Save options. (45486)
- Plugins within the Plugin Manager can now be sorted by name or version. (45223)
- Ability to load a single tool from a saved tool or process list is now supported. (44753)
- Added support within the Migration Tool to migrate customized UI settings. (45524)
- Tool Group and Position are now displayed on the flyout button in the tool list. (45376)
- Added the ability to filter tools within the Select Tool Type dialog. (45379)
- Icons within the Sync dialog now match the Operation list icons. (45475)
- Added two new B-Axis Lathe MMDs to the installer. (45361)
- Removed support for Datakit in GibbsCAM 12. (45403)
- Updated Spatial translator to import UGS/NX files. (45370)
- Added Toolpath Color Modes to display more information visually in the workspace. (45233)
- Added the option to assign to the root process folder when loading a saved process in order to see all the process files. (45169)
- The Task Manager will now reduce in size once tasks are completed and "Automatic Size" is enabled. (45295)
- The Modify Menu within Gibbs has been reorganized. (45122)
- Moved the "Show Do It/ Redo" menu item down from the top of the process list. (45031)
- Process progress menu will now auto fit the items when menu is displayed. (45167)
- Added support for custom tab colors on Op list and Tool List. (45140)
- Process & Tool flyouts can now be closed by using the Escape button. (45114)
- User preference for tile size in Tool, Process and Operation list is now preserved when closing GibbsCAM. (44599)
- Added mode option 'eStartRenderMode_RenderSelectedOps' for use in gc_StartRender to only render selected operations.
(45202)
- Added Operation tile indicators that display when there is an active modifier on the operation. (44597)
Bug Fixes
- Remote MDD folder now properly updates the DCD after setting the remote load folder. (46875)
- Modifying a pre-existing material within the materials dialog no longer generates an unhandled exception. (46861)
- Having "Forward" unchecked in the VoluTurn process dialog no longer produces a weird toolpath. (46630)
- Deburring process is now working as intended. (46846)
- Saved tools with Intermediate Tooling are now being loaded correctly. (46767)
- After saving a process list, the saved process list is now shown in the Load Process list flyout immediately. (46766)
- Japanese text can no longer be found in the Find Operations dialog in English. (46771)
- Mill Roughing no longer violates solid boundaries and produces a ramp through a part. (46678)
- Shortcut of "Control + T" now functions correctly for Reverse Arc. (46642)
- Part in the workspace no longer rotates when using Shift + Arrow keys in an active Search box. (46680)
- Right clicking a solid in the work space is no longer faulty and launches the pulldown menu properly. (46677)
- Simulation now displays the correct material removal without altering it based on rendering speed. (46665)
- Scaling display in Windows 7 no longer cuts off toolbar items. (46672)
- Part report no long outputs broken Stock values. (46629)
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- Adding family, material or alloy in the materials dialog now works correctly. (46625)
- Operation report no longer defaults Op Sim to 'Machine' POV lock, producing cut off images in the report. (46628)
- Lace Cut toolpath no longer significantly changes depending on solid body chord height. (46611)
- Within VoluMill, toolpath no longer generates air cuts and inefficient toolpath on main spindle due to fixtures on sub spindle.
(46404)
- GibbsCAM no longer crashes when rendering certain part files with FlashCPR. (46575)
- Tools with Intermediate Tooling no longer have rotary axes not properly rendering in simulation until the window for the tool
gets opened. (46580)
- GibbsCAM no hangs when deleting a tool from the tool list during rendering. (46220)
- Resolved display issues when viewing GibbsCAM on a 4K resolution screen. (465443)
- Using "Material Only" ithin VoluMill no longer produces inconsistent toolpath that gouges the part. (46182)
- A new library has been added to fix issues with X and Z stock values in VoluTurn. (46140)
- Fixed data retention of Back and Forth within VoluMill when cutting Reverse. (46520)
- Within Advanced 3D "Chord Height" will no longer have an impact on the values calculated by "Automatic". (46440)
- Fixed a material only problem related to unreasonable DCD stock sizes which do not contain the actual stock. (46053)
- Within Mill Contour using STL Body as stock no longer fails to machine to the desired depth. (46451)
- Modifications in a Toolblock previously created in Intermediate Tooling, no longer affects another Toolblock that was not
altered. (46488)
- Adding "Axis Values" in Tools > Toolblock Attachment Data now preserves Tool Holders in the Preview Rendering Image.
(46482)
- Typing non whole-numbers will no longer display a warning in TMS retract fields. (46474)
- Custom shortcut commands are no longer triggered when typing in other activated fields. (46469)
- Alloy data now updates in the material dialog when selecting a new matieral from the list. (45401)
- Intermediate Tooling components no longer appear to be missing when loaded. (46484)
- Legacy CPR now properly displays FP Thread Mill tools when rendering. (44539)
- Modifying the Entry Feed rate no longer removes ramping toolpath. (46367)
- Creating a new 5-axis process after a 3-to-5-axis conversion will now properly show the Surface Paths tab. (46387)
- Op comments no longer change in the included part when creating more operations or moving operations. (46205)
- Toolpath RMM "Select Only This Op" now updates the op list state. (46386)
- Dialog window borders no longer disappear when stacked and lose focus. (46320)
- Within macros the circle_2pr command no longer creates different geometry than previous GibbsCAM versions. (46334)
- False collisions will no longer be displayed between an Intermediate Tooling Block and an unloaded Sub Spindle. (46328)
- Op Sim is no longer rendering tool change interop postion when disabled in the DCD. (46316)
- "Do it" buttons no longer become available when no Geometry is selected. (46317)
- Surface palette is no longer enabled for use when it is not licensed. (46309)
- False Colisions are no longer displayed in Machine Simulation. (46331)
- Tool reports generated in French GibbsCAM are no longer missing tool images. (46199)
- Profiler on Facet body now works properly. (45431)
- Auto Clearance is no longer causing gouging toolpath after modifying non-relevant seeming data. (46023)
- GibbsCAM will no longer crash when loading a tool list. (46268)
- The icons in the command list for "Part Stations", "View Port Manager" and "Annotations" have been updated. (45507)
- Color palette no longer gets cut off when adding the "User Color of Selected" command to a Toolbar. (46273)
- GUI no longer becomes unresponsive after running AFR on a solid body with a large number of hole features. (46246)
- Closing the Intermediate Tooling Dialog now retains the CS List open. (46244)
- Spindle Selection is now properly retained when redoing a Lathe Threading Process. (46299)
- Within Plug-Ins > MDD PowerTools - "Examine Custom OP" function now working correctly. (46279)
- The Surface Tools - Center Curves Plug In no longer displays an erorr message when being used properly. (46014)
- Tool preview window no longer gets caught behind GibbsCAM and crashes on exit. (46274)
- Added a fix to 5-Axis saying tool is invalid when in a previous version it worked fine. (46229)
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- A bug has been fixed with Clearance Volume inter-operation calculations wherein lathe tools moving to or from off-part
locations could crash into the part. (46247)
- Default location for solids palettes are now better organized. (46109)
- A number of keyboard shortcuts bound to the numeric keypad now work correctly. (46102)
- Custom Operations now have display icons correctly. (45939)
- Floating Toolbar Transparency scroll buttons are no longer reversed. (46105)
- Both tool and tool block now rotate when changing orientation within intermediate tooling. (45977)
- Roughing processes now preserve previous settings when creating a new operation of the same type. (43657)
- Rough and Finish End Mill icons now match up with the icons in the tool list. (45968)
- Clicking the "Show Tool Holders" button on the Rendering Palette no longer causes a collision. (46065)
- A Machine Sim Error no long shows when trying to close the Simulation Settings dialog. (46056)
- We are no longer able to customize the Process Groups from the Select Tool Type dialog. (46072)
- The process list is now updated after processes are created via Hole Wizard. (46111)
- Robot Arm now renders correctly without flickering. (46018)
- GibbsCAM now displays correctly on 4K monitors. (45627)
- A crash will no longer occur when loading a custom .CUI file. (45998)
- Cutter Comp Offset in the tool dialog is now being properly retained. (45972)
- Tool Material in the tool dialog is now being retained when changed. (45971)
- Certain dialogs now no longer contain language varying text. (46002)
- Rotary Rough processes are no longer displayed in the process flyout if the current MDD does not have a rotary axis. (45956)
- The geometry sub menu is no longer displayed for appropriate commands when using a geometry command. (45957).
- Double clicking on the perimeter of the round View Palette no longer changes the size of the icon. (45056)
- Face selection commands now function correctly when placed within a custom toolbar. (45614)
- Loading a saved process multiple times no longer produces an error message "Error Opening Part". (44922)
- Within a Lathe Rough process the option "Back % Forth" is now retained properly when redoing the operation. (45736)
- When creating a new Lathe Rough process the option "Cut Depth" properly preserves the last used value. (45807)
- The "X Dia. Stock Position" field within VoluTurn is no longer ignored. (45348)
- The Union command now functions properly when added to a custom toolbar. (45822)
- Windows Taskbar can now be accessed correctly when Gibbs is full screened. (45896)
- Tool numbers are now preserved correctly when loading a saved tool list. (45850)
- Get Draft Angle plugin is now under the Plugins > Solids menu. (44935)
- Installer no longer contains overlapping images within the prerequisites dialog. (45367)
- Generation of TMS reports no longer causes a crash of GibbsCAM. (45840)
- GibbsCAM no longer crashes when changing MDDs. (45745)
- The installer now updates the Space Required on the drive when changing the install location. (45094)
- Autodesk (DWG) files are now able to be properly imported into GibbsCAM. (45493)
- Material Only is now properly taken into account within VoluMill processes. (45342)
- Finish Stock values are now properly accounted for within VoluMill processes. (45591)
- Dragging and dropping .ipt files into GibbsCAM now imports them. (45785)
- Dialog windows now properly display after minimizing then maximizing Gibbs. (45811)
- Creaing a Deburring process and adding a tool no longer causes a unhandled exception. (451160)
- Custom plugins now show up after first launch when added to the system. (45645)
- Entering a minimum toolpath radius of 0.0 within VoluTurn no longer results in an infinite amount of warnings. (45633)
- Scrollable menus no longer overlap the command bar. (45759)
- Tooltips are now being displayed on commands with dropdown menus. (45766)
- Process files (*.prc) will now import correctly. (45700)
- Preview pane is now supported within version 12. (45095)
- The DCD now correctly retains changes made within the Multi-Part tab. (45534)
- The GibbsCAM installer now retains selected install features when navigating back and forth between options. (45305)
- Running operation summary off a GCPKG no longer causes a crash. (45519)
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- No more extra parts are displayed in simulation when a solid is defined as stock. (45532)
- The "Raw Material" setting within Adaptive Pocketing is no longer ignored. (45246)
- GibbsCAM is no longer displayed as 32bit within the Migration tools "Migrate From" list. (45146)
- The Materials dialog is now properly populated within GibbsCAM. (45097)
- It is now possible to change the CutDATA path to CutDATA.txt in the Preference dialog. (45180)
- Using Ctrl+A to select all will no longer select tools as well as items in the workspace. (45629)
- The CS pulldown menu now displays CS names correctly. (45583)
- Fields in the DCD machining preferences tab now correctly adjust when downsizing the DCD. (45304)
- GibbsCAM no longer crashes after attempting to refresh a Toolblack for the 2nd time. (45536)
- Features are no longer removed when slicing Facet bodies. (45395)
- The workspace should no longer display when minimizing GibbsCAM. (45374)
- A crash will no longer occur when opening Gibbs and clicking the "Do it" or "Redo" buttons. (45520)
- Setting the Clearance Volume tolerance higher than 10% will no longer cause Machine Simulation to produce errors and crash.
(45489)
- Using the Redo button on the title bar of a roughing process now updates the toolpath correctly. (45533)
- Simulation now displays all parts of a Tombstone part during rendering. (45545)
- Scrolling arrows now function correctly on menus. (45478)
- Process dialogs will no longer be opened by a quick left then right click. (45528)
- After loading a .cui file to customize the layout of GibbsCAM, the layout will no longer incorrectly display varying groups.
(45510)
- A crash will no longer occur when hovering over the progress bar while redoing a process. (45471)
- The print command can now be moved into a toolbar when customizing. (45491)
- The Do It and Redo buttons no longer pop up when right clicking on the Hole Wizard title bar. (45492)
- Process and Operation tiles will now be updated automatically when changing the Tool Position or Tool Group. (45537)
- Clicking on the Turret Shift/ Tool Preset button in the Tool dialog will no longer cause Gibbs to crash. (45518)
- The Translate plug-in under Transform Ops will no longer produce an error when translating operations. (43197)
- When selecting a solid, options in the right click menu are no longer incorrectly grayed out. (45388)
- GibbsCAM will no longer crash during rendering when using the setting "Show Time". (45363)
- After running an Operation Report using "Use Legacy CPR" Op Sim will no longer begin running. (45444)
- Spacers from the Customize Toolbars & Menus option will now space toolbars correctly when they are not expanded. (45375)
- Op Color now displays properly within rendering. (45391)
- User Color option now works properly when selecting a solid. (45389)
- The GibbsCAM installer will no longer produce an error installing C++ prerequisites. (45132)
- When using Sliced Spun Body on an STL the profile will no longer be incorrectly rotated. (45343)
- You can now copy and paste processes without errors. (44580)
- The shortcut for Shrink Wrap is now properly set to Ctrl+`. (45450)
- Features are no longer removed when slicing Facet bodies. (45395)
- Pathfinder will now navigate to the correct Saved Processes Folder. (45178)
- The "Don't Show" setting on the Do it/ Redo check box is now properly retained upon closing GibbsCAM. (45237)
- The "Move To" function will now correctly move Operation and Tool tiles to designated tile. (45299)
- The system will no longer hang when loading a new part while Gibs is regenerating an operation. (45300)
- The "Tick Delay" that is set within Tooltips now properly applies when hovering certain icons. (45307)
- A crash will no longer occur when clicking "Close All" while having the CAM palette open. (45324)
- Loading recently saved tools will no longer produce an error "Error Opening Part". (45101)
- Pressing the enter/ return key will now correctly add an extra line in the Part Comment or Programmer Notes field in the DCD.
(45269)
- When using "Small Tiles" triple digit operation tile numbers now display without being cut off. (45274)
- The Macros menu is now properly preserved and will not disappear upon relaunching GibbsCAM. (45054)
- Tool holder no longer clashes with Toolgroup sim body nose because of the Sub Position. (45026)
- GibbsCAM will no longer stall or appear to freeze when shift clicking multiple Hole Features. (45219)
file:///C:/Users/RAPPB/Desktop/getfile.html

12/13

10/19/2018

GibbsCAM Update List

- Selecting "Enable Caption" within the preferences will no longer cause GibbsCAM to crash upon launch. (45192)
- Grayed out dialogs in the top menu will no longer feature non-grayed out text. (45121)
- Pack and Go will now correctly produces a complete *.gcpkg file. (45090)
- The size of machining markers will no longer prevent zooming with the scroll wheel. (45100)
- Dragging and dropping Solidworks *.SLDPRT files into Gibbs no longer produces an Import Failed error. (44926)
- Tool holders will no longer clash with Toolgroup sim body node because of Sub Position. (45026)
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